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[bookmark: _Toc99538928]List of figures, tables and source codes
(figures, tables and source codes will be grouped into two lists and will be numbered as found in the text)
FIGURES
Figure 1. This is an example of a figure.
Figure 2. Explanatory text for another figure.

TABLES
Table 1.This is an example of a table.

SOURCE CODES
Code 1. Explanatory source code.

Note!
These lists are optional depending on the quality requirements imposed by the department and the scientific coordinator.
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[bookmark: _Toc99538929]Acronym list
(all abbreviations used will be written in alphabetical)
abs – absolute;
IESC – Inginerie Electrică și Știința Calculatoarelor (Electrical Engineering and Computer Science);











[bookmark: _Toc37406680][bookmark: _Toc99538930]Introduction


[bookmark: _Toc99538931]Sumary
This document includes a template provided to IESC faculty students for drafting the diploma project. The document refers both to the graphic form of the works and to its content.
This chapter only covers the formatting of the paper. For instructions on the content of the paper and to define as accurately as possible the content of the chapters in the paper, you should read the next chapter and for any questions please contact the scientific coordinator.
[bookmark: _Toc513218237][bookmark: _Toc99538932]Fonts
Fonts are very important for the overall image of the work. Transilvania University of Brașov has its own font, called "UT Sans". It is an original font that you can get from the intranet.unitbv.ro website. Intranet menu>Identitatevizuală[1].
Fonts need to be installed to edit the project correctly.
Fonts are specific to Word paragraph styles. It is recommended to keep the styles unchanged and only associate the paragraphs with certain styles depending on the content.
If the font is not the one you want, you can apply the desired style by selecting the paragraph and selecting the style from the appropriate box: Style.
[bookmark: _Toc513218229][bookmark: _Toc37406682][bookmark: _Toc99538933]First page editing
Do not change the fonts and formatting of characters (italics, bold, underline, etc.) on the first page. Delete the initial patterned text and replace it with your own text, keeping the fonts and text formatting.
On the first page, change the title of the paper. Change the student's name, family name in capital letters. Change the teacher nameof the scientific coordinator, the family name in capital letters. If you don't know the titles (title), you'd better ask him than guess them.
[bookmark: _Toc513218230][bookmark: _Toc37406683][bookmark: _Toc99538934]Structuring the paper
The paper is structured in chapters, subchapters and sections (maximum 3 hierarchical levels). These are written as follows.
Chapter title is written using style “Heading 1”.
An chapter include one or more than one subchapters.
[bookmark: _Toc513218231][bookmark: _Toc37406684][bookmark: _Toc99538935]Subchapter
The title of the sub-chapter is written in the style "Heading 2". Following are the paragraphs that are written using the "Normal" style. 
[bookmark: _Toc513218232][bookmark: _Toc37406685][bookmark: _Toc99538936]Other subchapter
This subchapter also has several sections…
[bookmark: _Toc513218233][bookmark: _Toc37406686][bookmark: _Toc99538937]One section
The sections are written in the "Heading 3" style. Then comes the text with the style "Normal" and a new section that will be automatically numbered if associated with the appropriate style.
[bookmark: _Toc513218234][bookmark: _Toc37406687][bookmark: _Toc99538938]Another section of the same subchapter
And so on...
[bookmark: _Toc513218235][bookmark: _Toc37406688][bookmark: _Toc99538939]Management of figures, formulas and tables
The figures attract the eyes of readers / evaluators. If the figures are "self-explained" you will make a better impression. For this, there are the following recommendations:
· Include only original, clearly made figures. Don't take figures from colleagues. Some readers have a good visual memory.
· Avoid poor quality images with text in other languages. If an image is still relevant, explicitly mark the source in the bibliography (as mentioned in the chapter Citing references).
· Figures must be accompanied by an explanatory text below the figure (caption). The text should make it possible to understand the figure without having to read paragraphs from the text. The figure and the explanatory text will be centered on the page, horizontally[image: ].
· If you want to insert a new figure, it is recommended that you copy the explanatory text from another figure (including formatting and tags, copy & paste) and then add the figure and edit the explanatory text.
· Avoid multi-colored figures. If it is relevant to have color images, you will need to print those pages with a color printer.
[image: fig7_4]
Figure 1 This is an example of a figure.
Avoid the explanatory text of a figure appearing on the next page by positioning the cursor on the line with the figure and Right-click> Paragraph> Line and page breaks> Keep with next.

Figure 2 Explanatory text for another figure. 
[bookmark: _Toc513218236]Avoid putting multiple figures one after the other. Insert small text between figures. Also try to make the figures large or small enough to be easy to read and understand by the reader.
Equations are written using the Word Equation Editor, centered on the page, and numbered in order of appearance in round brackets.Exemple:

		(1)
In the text the reference to the equation will be accompanied by the number in round brackets, as seen for example in equation 1.
The tables will be inserted centered on the sheet and will have an explanatory note (UT Sans, 10, Normal, right alignment) as in the example below:

Table 1.Table example.
	Nr. crt.
	Numele și prenumele
	Nota 1
	Nota 2
	Media

	1.
	
	
	
	

	2.
	
	
	
	

	3.
	
	
	
	


[bookmark: _Toc99538940]
General recomandations
Do not leave additional rows blank. The style associated with a paragraph includes the required settings.
Do not number paragraph headings. They will be numbered automatically.
To mark a paragraph title, position your cursor over it and change its style to the desired one: Heading 1, Heading 2, Heading 3. It is not recommended to use more than 3 sub-paragraph levels.
The Header will be written with the same UT Sans 10 font and will be different on even and odd pages. The title of the diploma project will be written on odd pages and the name of the candidate will be written on even pages. The Footer will be inserted by inserting the centered page number using the same font with a height of 12 points. The insertion of the Header and Footer is done using the Insert menu and then we choose one of the Header or Footer options.
If you want to put a figure in Landscape format, you need to insert a section in the document with the commands Page Layout> Brakes> Section Breaks> Next Page. If you want to return (after one or more pages) to the original Portrait format, you need to enter another section. Position your cursor in the middle section (which you want to turn into Landscape) and call the Page Layout> Orientation> Landscape commands. You will get a Landscape section between two Portrait sections. You can now edit the figure in the Landscape section..
[bookmark: _Toc513218238][bookmark: _Toc99538941]Source code
You can include source code in the text of the paper. Plain text style is recommended. The Courier New font has the property that the width of all letters is constant (independent of the letter). This will make the code written with plain text editors appear aligned correctly. To insert a source code, copy the code and then set the "Plain text " style.
If you do not want to move to a new page in the middle of the code, explicitly insert Page break before the source code. Of course, the code should have explanatory comments. To make it easier to identify, each source code will have an explanatory text (caption) similar to the one used in the figures so that it can be more easily referenced in the text. For examplesee code 1.

modulemux_parameter#(
parameter NR_OF_CLIENTS                     = 'd4         , 
parameter DATA_WIDTH                        = 'd4           
)(
input   [NR_OF_CLIENTS                - 1:0]  selection     , 
input   [NR_OF_CLIENTS * DATA_WIDTH   - 1:0]  data_in       , 
outputreg              [DATA_WIDTH   - 1:0]  data_out
);
integeri;
always @(*) begin
data_out = data_in;  // ha haha
end
endmodule       // mux_parameter

[bookmark: _Toc513218239]Code1Explanatory source code.
[bookmark: _Toc99538942]Fast commands
Updating the content presented in the table of contents (present at the beginning of the paper) and the figures can be done by fully selecting the document (CTRL + A) followed by right-click and Update field> Update Entire Table.
A new page is started by inserting the "Page break" character by pressing CTRL + ENTER.
A chapter (Heading 1) will start on a new page. To do this, type CTRL + ENTER at the end of the previous chapter to insert the "Page break" character.
You can get a view of the structure of the work by calling the View menu, the Outline option. You can move chapters, increase them, or decrease the hierarchy of paragraphs in the document.
You can see the editor control characters in the Home menu, option[image: ].
[bookmark: _Ref513217018][bookmark: _Toc513218240][bookmark: _Toc99538943]References citing
In the paper you need to quote texts from other bibliographic sources. It is essential that these texts are clearly highlighted as taken from the bibliography. Quotations from the bibliography will be written in double quotation marks in italics and will be accompanied by a citation of the bibliography (index of the paper in square brackets).
Example
In [6] the author presents fundamental aspects of image processing and states that "First, remotely …".
Example
The citation of a bibliographic work is done in the text by marking the reference number in square brackets and the corresponding labeling of the information in the Bibliography chapter. "Sooner or later, something in your world will change fundamentally"[4].
The referred paper will be presented in the Bibliography chapter, having the same index in square brackets.

[bookmark: _Toc513218241][bookmark: _Toc99538944]Google
Search for references (books and scientific articles) is recommended on the Google Scholar application (https://scholar.google.com).
An example of a keyword search results is shown in Figure 4.

[bookmark: _Ref513216352][image: ]
Figure 4Search results for referencies with keywords “image processing”.
Clicking on the quotation mark character [image: ]brings up a list of 3 citation options. Choose APA mode and copy & paste in the paper.
[image: ]
Figure 5 Image with reference citation variants.
It is recommended that the order in which the references appear in the paper be in ascending order, starting with number 1.
If you refer to catalog sheets, implementation examples, commercially available variants, general information on wikipedia pages you found on the Internet, write the name of the reference that characterizes the content and the URL (web page or document address) [7], [8].
[bookmark: _Toc37406689]
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[bookmark: _Toc99538946]Recommendations regarding the content of the chapters
The project must contain at least 40 pages, according to this format, of which at least 30 pages will contain the specific aspects developed by the author (software development / use / application, design, modeling, practical realization, etc.).
The first chapter is an introductory one, in which the author argues the need and importance of the project theme in close connection with some comparisons between the existing ways of solving the theme to highlight the originality of the approach to the project. and the objectives of the paper as well as the structuring on chapters.This chapter should not exceed 10 pages.
The second chapter summarizes the theoretical aspects related to the topic, which will be referred to in Chapter Three for solving the design topic. The summary should be made so that it does not exceed 10 pages, so present only the theoretical aspects absolutely necessary to substantiate the next chapter.
The next chapter contains original parts, design, simulations developed by the author of the project. Here you must present all the aspects implemented for solving the design theme such as the practical part, the choice of components, the choice of the most convenient solutions taking into account the theoretical aspects presented in Chapter Two. The calculation program used can be presented and argued.
The last chapter is about the conclusions on how the objectives were achieved, the results obtained, the usefulness of solving the topic, the author's contributions and future research / development directions. This chapter may also contain a technical-economic analysis regarding the estimation of some costs and possibilities to reduce them.
At the end of the project, all the bibliographic references used for the elaboration of the project will be obligatory.
The submission of the diploma project, to which the Project Sheet is attached (see pages 2 and 3), which also includes assessments on the content of the paper by the scientific leader, is made 5 calendar days before the date on which the start of the final exam is scheduled. It is advisable that at the enrolement to the exam  (10 days before)  your project has to be at the final steps of veriffication by your scientific coordinator.
At the beginning of the project, the lists of figures and tables in the project and a list of the acronyms used will be presented after the table of contents.
At the end of the project, in the Abstract page, you will summarize a maximum of 300 words of the project. This summary will also be translated into English on the page called Rezumat.
[bookmark: _Toc99538947]Presentation of diploma project
The presentation will be oriented towards the results obtained and personal contributions, without insisting on the general theoretical aspects.
The structure of a presentation is as follows:
1. the title of the project, the name of the author, the name of the scientific director and the year of the support;
1. the content of the project;
1. objectives of the paper;
1. brief presentation of the theoretical support;
1. presentation of theoretical and experimental results as a result of approaching the project theme;
1. conclusions, highlighting personal contributions.
The number of slides depends on the topic, but the presentation must be within the time limit set by the committee, which will be communicated to you by each committee.
It is recommended that the presentation be made using Microsoft Powerpoint, the content being in accordance with the recommendations of the leading teacher. If the experiments performed cannot be presented in the examination room, short illustrative films may be submitted to the committee.	
If you have practical achievements, it is recommended that you bring them to the room and check them functionally before starting the presentations that day. It is desirable to make sure that the settings and programs work on the computers provided by the faculty and if you have special needs to make sure that you can make the presentation from your personal device (phone, laptop, etc.).
The registration for the license exam will be done using the application presented in Annex 1 and the composition of the registration file can be found in Annex 2.
The evaluation of the diploma project will take into account the evaluation grid presented in Annex 3.
The declaration of originality must be attached at the end of the project and must be completed and signed.
[bookmark: _Ref513156981][bookmark: _Ref513157015][bookmark: _Ref513157019][bookmark: _Toc513218242]
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(o descriere sumara, în limba română, a principalelor aspecte tratate în proiect – maxim 300 de cuvinte)






[bookmark: _Toc99538950]Abstract
(short description, in english, of main aspects treated in the project)
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Titlul proiectului de diplomă
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[bookmark: _Toc99538951]Annex 1
UNIVERSITATEA TRANSILVANIA DIN BRAŞOV
FACULTATEA _______________________________

CERERE DE ÎNSCRIERE LA EXAMENUL DE _______________________

I. Date personale ale candidatului/ candidatei comunicate în scopul prelucrării necesare pentru organizarea examenului de finalizare studii
1. Date privind identitatea persoanei
Numele de naştere:______________________  Numele (dacă este cazul):__________________
Prenumele: _____________________________ CNP ____________________________
2. Sexul:   Feminin 	 Masculin
3. Data şi locul naşterii:
Ziua / luna / anul ________ /_________________ / __________
Locul (localitate, județ, țara) _______________ / __________________/ _______________
4. Prenumele părinților:
Tata: ___________________________Mama:__________________________________
5. Domiciliul stabil: Localitatea _______________, jud. ________________Cod poştal ______,
str. ________________________________________ nr.___, bloc ___, sc.__, et. __, ap.__, 
Telefon _______________, mail _________________

II. Date privind şcolarizarea
6. Sunt absolvent(ă) promoția: ______ / _______ (anul înmatriculării / anul absolvirii)
7. Mențiuni privind şcolarizarea: _______________________________________________
_____________________________________________________________________
8. Programul de studii ______________________________________________________
9. Durata studiilor _________________________________________________________
10. Forma de învățământ absolvită: 		IF	IFR	ID
Fără taxă	 Cu taxă
11. Solicit înscrierea la examenul de __________, sesiunea ______________ anul __________
12. Lucrarea/ Proiectul de __________pe care o susțin are următorul titlu:_________________ 
_____________________________________________________________________

13. Conducător ştiințific:____________________________________________________
14. Susțin examenul de ____________(pentru prima oară, a doua oară - dupăcaz) _________________.
15. Menționez că sunt de acord cu afişarea rezultatelor examenului conform art.15 alin.9/art.18 alin.9 din OMENCS nr.6125/2016 modificat prin OMEN nr.5643/2017. 

SEMNĂTURA,							VERIFICAT,
Secretar facultate
_________________________________		____________________
(numele şi prenumele, semnătura)	F05-PS 7.6-01/ed.2,rev.2

[bookmark: _Toc99538952]Annex 2

Diploma / dissertation exam registration file

In order to register for the bachelor's / diploma / dissertation exam, graduates must submit the following documents to the secretariat:
1. Application for registration for the exam
2. Declaration on personal responsibility regarding the processing of personal data in the framework of the procedure for organizing the bachelor's / diploma / dissertation exam
3. Birth certificate, in legalized copy or in simple copy that has been certified “According to the original” by the authorized person from the secretariat of the faculty, based on the presentation of the document in original;
4. Marriage certificate (if applicable), in certified copy or in plain copy which has been certified “According to the original” by the authorized person from the secretariat of the faculty, based on the presentation of the original document;
5. Order of the rector to change the name of the graduate (if applicable);
6. Baccalaureate diploma or equivalent, in certified copy or in plain copy, certified "According to the original" by the authorized person from the faculty secretariat, based on the presentation of the original document - for the bachelor's / diploma exam;
7. Bachelor's degree or engineering degree and the annex to the diploma, in certified copy or in plain copy that has been certified "According to the original" by the authorized person from the faculty secretariat, based on the presentation of the original document - for the dissertation exam;
8. Certificate of language proficiency (only for the bachelor's or diploma examination), issued by the organizing institution or by another specialized institution, national or international, recognized by the organizing institution.
For their own graduates, the language skills certified by the notes in the register in a foreign language of wide international communication are recognized by the Department of Theoretical and Applied Linguistics, without the need for a language proficiency certificate attached to the file.
For graduates who take the bachelor's / diploma exams at other higher education institutions, as well as for graduates of other higher education institutions who take the bachelor's / diploma exams at UTBv, the existence in the file of the language proficiency certificate is mandatory.
9. 2 color photos, recent, size ¾ cm, on photo paper;
10. Copy of identity card or passport;
11. Copy of the Letter of Acceptance for Studies / MEN Order or Equivalence Certificate (if applicable);
12. Receipt of payment of the examination fee (if applicable);
13. Declaration on own responsibility regarding the originality of the bachelor's thesis / diploma project / dissertation;
Graduates from other higher education institutions will submit the documents provided in points 1-13, to which are added:
14. Diploma supplement, issued by the state or private higher education institution graduated, showing, for each semester and year of study, the subjects promoted, the number of hours provided for each course, applications, practical work - separately, form verification (examination, colloquium, project, verification), credits and marks obtained. and a copy of the Diploma Supplement, certified "according to the original" by the issuing faculty;
15. Certificate issued by the state or private higher education institution graduated, from which to result the quality of graduate, drawn up in accordance with the Order ...................... ..........

The documents are submitted to the secretariat of the faculty in a cardboard envelope file, on which are written:
· Name and surname of the graduate;
· Study program
· The faculty
· The session
· The promotion


Note: The certification of the conformity with the original of the children according to the identity / civil status documents and the study documents is done by the designated employees within the faculty, based on the presentation of the original document.


Dosar de înscriere la examenul de diplomă/disertație

Pentru înscrierea la examenul de licență/ diplomă/ disertație, absolvenții trebuie să depună la secretariat următoarele acte:
1. Cerere de înscriere la examen
2. Declarație pe proprie răspundere privind prelucrarea datelor cu caracter personal în cadrul procedurii de organizare a examenului de licență/diplomă/disertație
3. Certificat de naştere, în copie legalizată sau în copie simplă care a fost certificată „Conform cu originalul” de către persoana autorizată din secretariatul facultății, în baza prezentării actului în original;
4. Certificat de căsătorie (dacă este cazul), în copie legalizată sau în copie simplă care a fost certificată „Conform cu originalul” de către persoana autorizată din secretariatul facultății, în baza prezentării actului în original;
5. Ordin al rectorului de schimbare a numelui absolventului (dacă este cazul);
6. Diplomă de bacalaureat sau echivalentă cu aceasta, în copie legalizată sau în copie simplă, certificată „Conform cu originalul” de către persoana autorizată din secretariatul facultății, în baza prezentării actului în original – pentru examenul de licență/diplomă;
7. Diploma de licență sau diplomă de inginer şi anexa la diplomă, în copie legalizată sauîn copie simplă care a fost certificată „Conform cu originalul” de către persoana autorizată din secretariatul facultății, în baza prezentării actului în original – pentru examenul de disertație;
8. Certificat de competență lingvistică (numai pentru examenul de licență sau de diplomă), eliberat de instituția organizatoare sau de o altă instituție specializată, națională sau internațională, recunoscută de instituția organizatoare. 
Pentru absolvenții proprii, competențele lingvistice certificate prin notele din registrul matricol la o limbă străină de largă comunicare internațională sunt recunoscute de Departamentul de Lingvistică teoretică şi aplicată, fără a mai fi necesar un certificat de competență lingvistică ataşat la dosar.
Pentru absolvenții proprii care susțin examenele de licență/diplomă la alte instituții de învățământ superior, precum şi pentru absolvenții altor instituții de învățământ superior care susțin examenele de licență/diplomă la UTBv, existența în dosar a certificatului de competență lingvistică este obligatorie.
9. 2 fotografii color, recente, dimensiunea ¾ cm, pe hârtie fotografică; 
10. Carte de identitate sau paşaport, în copie;
11. Copie a Scrisorii de acceptare la studii / Ordinului MEN sau Atestatului de echivalare (dacă este cazul);
12. Chitanța de plată a taxei de examen (dacă este cazul);
13. Declarație pe proprie răspundere privind originalitatea lucrării de licență/ proiectului de diplomă/disertației;
Absolvenții proveniți de la alte instituții de învățământ superior vor depune documentele prevăzute la pt.1-13, la care se adaugă:
14. Suplimentul la diplomă, eliberat de instituția de învățământ de stat sau particular superior absolvită, din care să rezulte, pentru fiecare semestru şi an de studii, disciplinele promovate, numărul de ore prevăzut pentru fiecare curs, aplicații, lucrări practice – separat, forma de verificare (examen, colocviu, proiect, verificare), creditele şi notele obținute. şi o copie a Suplimentului la diplomă, certificată „conform cu originalul” de către facultatea care o eliberează;
15. Adeverință eliberată de instituția de învățământ de stat sau particular superior absolvită, din care să rezulte calitatea de absolvent, întocmită în conformitate cu Ordinul ................................

Documentele se depun la secretariatul facultății într-un dosar plic de carton, pe care se înscriu:
· Numele şi prenumele absolventului;
· Programul de studii
· Facultatea 
· Sesiunea
·  Promoția 


Notă: Certificarea conformității cu originalul a copiilor după actele de identitate/de stare civilă şi a actelor de studii se face de către angajații desemnați din cadrul facultății, în baza prezentării documentului în original.






[bookmark: _Toc99538953]Annex 3
Graduation project evaluation grid

Be careful!
The grade for the diploma project will include a grade for the printed format of the diploma paper, a grade for the oral presentation and a grade for the answer to the questions. Each grade will have a certain weight in the final grade awarded according to the examination board. For the printed part of the draft diploma, the examination commission will award points according to the following criteria in certain weights established by each examination commission:

1. Content

1.1.Originality
KPIs
1. Originality of the project idea.
1. Original hardware / software / netware fixes.
1. Relationship between the material developed by the student and the material taken from the bibliography / webography, etc.

1.2. Scientific level
KPIs
· Clarity of proposed objectives.
· The quality of the documentation of the current stage in the field of the project.
· Quality and accuracy of bibliography / webography.
· Clarity of project achievements (existence of explanatory schemes).
· Hardware / software / netware design quality.
· Simulation / emulation / experimentation / testing-validation of implemented systems / processes.
· Relevance of the conclusions following the realization of the project.

1.3.Complexity
KPIs
· The degree of complexity of hardware / software / netware implementation.
· The degree of depth of the realization (completely new project or development starting from a previous project / concept).
·  Complexity of simulations / experiments (simulation program used, degree of accuracy of the simulation, results obtained).

1.4.Implementation level
KPIs
· The degree of finalization in relation to the proposed objectives.
· Complexity of functionality
· Demonstration of functionality, commissioning of the model or device, running programs, etc.

Plagiarism check
· Works with a total Turnitin similarity percentage greater than 15% are not accepted.
· Works with a Turnitin similarity rate greaterthan 5% from a single source are not accepted.
· [bookmark: _GoBack]The visa coordinator for anti-plagiarism based on the Turnitin report is required in the last visa box on the project file.

2.Form
KPIs
1. Graphic form as a whole, image quality, quality of multimedia presentations.
1. Correctness in using the Romanian / English language; translation of parts of text from figures into Romanian / English, except for catalog sheets and other scanned documents; explanation of acronyms in other languages.
1. Compliance with the editing requirements and the quantity requirement of the material.


	[bookmark: _Toc99538954]ORIGINALITY DECLARATION / DECLARAȚIE PRIVIND ORIGINALITATEA
LUCRĂRII DE LICENȚĂ / PROIECTULUI DE DIPLOMĂ / DISERTAȚIEI


	
UNIVERSITATEA TRANSILVANIA  DIN BRAŞOV
FACULTATEA  INGINERIE ELECTRICĂ ȘI ȘTIINȚA CALCULATOARELOR
PROGRAMUL DE STUDII ........................................................................................................................................

	NUMELE ŞI PRENUMELE........................................................................................................................................
PROMOȚIA...................................................................
SESIUNEA ....................................................................

	TEMA LUCRĂRII / PROIECTULUI/ DISERTAȚIEI
........................................................................................................................................................................................
........................................................................................................................................................................................
CONDUCĂTOR ŞTIINȚIFIC ......................................................................................................................................


	
Declar pe propria răspundere că lucrarea de față este rezultatul muncii proprii, pe baza cercetărilor proprii şi pe baza informațiilor obținute din surse care au fost citate şi indicate conform normelor etice, în textul lucrării/proiectului,  în note şi în bibliografie.

Declar că nu s-a folosit în mod tacit sau ilegal munca altora şi că nici o parte din teză/proiect nu încalcă drepturile de proprietate intelectuală ale altcuiva, persoană fizică sau juridică.

Declar că lucrarea/ proiectul nu a mai fost prezentat(ă) sub această formă vreunei instituții de învățământ superior în vederea obținerii unui grad sau titlu ştiințific ori didactic.

În cazul constatării ulterioare a unor declarații false, voi suporta rigorile legii.




	Data: ...................................                            
Absolvent
...................................                            
 (nume, prenume, semnătură )
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Introductory digital image processing: a remote sensing perspective
JR Jensen, K Lula - 1987 - Taylor & Francis

Dr. Jensen has produced a good book which is written in a clear and lucid style. The book
introduces the fundamental of image science and processing to a reader who has basic
background in remote sensing. Among many gaod features of this book, the following are
¥ 99 Citat de 8506 ori Aticole cu confinut similar Toate cele 13 versiuni

[carTe] The image processing handbook

JC Russ - 2016 - taylorfiancis. com

Image processing is used in a wide variety of applications, for two somewhat difierent
purposes: 1. improving the visual appearance of images to & human observer, including
their pinting and transrmission, and 2. preparing images for the measurement of the features
% 99 Citat de B892 ori Aticole cu confinut similar Toate cele 23 versiuni 90

Two-dimensional signal and image processing
JS Lim - Englewsod Clifs, NJ, Prentice Hall, 1990, 710 p., 1990 - adsabs harvard edu
Theoretical and applications aspects of digital processing for two-dimensional signals or
images are exarmined in a textbook for advanced undergraduate and graduate students of
engineering or cormputer science. Chapters are devated to signals, systers, and the Fourier
% 99 Citat de 3346 ori Aicole cu confinut similar Toate cele 4 versiuni




image7.png
vy




image8.png
MLA

APA

Chicago

Harvard

Vancouver

Cite

Jensen, John R., and Kalmesh Lulla. "Introductory digital
image processing: a remote sensing perspective." (1987): 65-
65.

Jensen, J. R., & Lulla, K. (1987). Introductory digital image
processing: a remote sensing perspective.

Jensen, John R., and Kalmesh Lulla. "Introductory digital
image processing: a remote sensing perspective." (1987): 65-
65.

Jensen, J.R. and Lulla, K., 1987. Introductory digital image
processing: a remote sensing perspective.

Jensen JR, Lulla K. Introductory digital image processing: a
remote sensing perspective.

BibTeX EndNote RefMan RefWorks




image1.png
Universitatea
Transilvania
din Brasov

FACULTATEA DE INGINERIE ELECTRICA
SISTIINTA CALCULATOARELOR




